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4.2   HOW DO I USE DIGITAL IDS 
 

Basic 
Principle  

Once you receive a Digital ID, you need to install it in the Outlook 
Express mail application required for this test. Once set up correctly, 
the mail application does most of the work for you, which makes 
using Digital IDs fairly easy. 
 
In this context, you can secure e-mail to do the following: 
 
 Digitally sign a message so that the recipient can verify the 

message came from you and not from an impostor. It is worth 
noting that signing a message also ensures its integrity, that is, it 
ensures that no one tampered with the message 

 
 Encrypt a message so that no one can read it while it travels from 

your computer to another 
 
As explained here above, when sending encrypted (secure) e-mails, 
firstly, you need to retrieve Digital IDs from people you communicate 
with, and then you can configure your e-mail application to encrypt 
your messages to those people. 
 
In addition, it is pointed out that you can set up most e-mail 
applications to automatically sign and/or encrypt your messages or 
you can manually choose to do it on a case-by-case basis. 
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4.3  INSTRUCTIONS FOR INSTALLING YOUR PERSONAL CERTIFICATES  
 

Purpose  Before sending and receiving secure e-mail, you have to install your 
personal certificate (digital ID) and the root certificate on your local 
workstation. The digital ID will allow you to sign e-mail with a digital 
signature that can verify who you are. It will be unique to you, just 
like your signature.  
 
On the other hand, the root certificate is also mandatory because it 
will identify the official Certification Authority (CA) being in charge of 
signing and issuing the personal certificates for this test activity. It is 
called a root certificate because it is the certificate for the root CA. 
There is no higher certifying authority to sign its CA certificate. 
 
Both certificates will be sent to the persons participating in this test 
phase by e-mail and the instructions described below will have to be 
carried out step-by-step: 

 
Installation 
instructions  

The following certificate files will be attached to the e-mail: 
 

 Root_CA 
 EC_CA 
 Mail.pfx 

 
1. Root_CA file installation 
 
Once copied on the local hard drive, you just double-click on the 
Root_CA file and follow the wizard: 
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INSTRUCTIONS FOR INSTALLING YOUR PERSONAL CERTIFICATES, 
CONTINUED  

 
Installation 
instructions, 
continued  

As you can notice, by default the CA Root certificate is not trusted by 
windows and therefore, to enable trust, the aim is to install this 
certificate in the Trusted Root Certification Authorities store by simply 
clicking on the “Install Certificate” button 
 

 Click on “Install Certificate” to proceed to the installation of the 
root certificate 

 

 
 Click on “Next” to continue 

 

 
This stage is to copy the root CA certificate in the Microsoft Trusted 
Root Certification Authorities store. Use the default parameter and 
click on “Next” to continue: 
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INSTRUCTIONS FOR INSTALLING YOUR PERSONAL CERTIFICATES, 
CONTINUED  

 
Installation 
instructions, 
continued 

 
The installation is completed. When clicking on “Finish”, the 
following security warning message will pop up on screen: 
 

 
This message is a normal behavior because the official certification 
authority (i.e. EC Certification Authority) is unknown by default by 
Windows and therefore is not trustworthy. To trust it, you just have to 
click on “Yes” so that the process can be successfully completed. 
 
 
2. EC_CA file installation 
 
This certificate is required to recognize the official Certification 
Authority. To install this file in Windows, simply double-click it and 
follow the wizard.  
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INSTRUCTIONS FOR INSTALLING YOUR PERSONAL CERTIFICATES, 
CONTINUED  

 
Installation 
instructions, 
continued 

 
 
You click on “Install Certificate…” and then when other windows 
appears, you just click on “Next” until its completion without 
changing any parameter 
 
 
3. Mail.pfx file installation 
 
To install this file in Windows, simply double-click it and follow the 
wizard: 
 

 
This window shows you the file name location. By default the 
location is correct and you can click on “Next” to continue 
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INSTRUCTIONS FOR INSTALLING YOUR PERSONAL CERTIFICATES, 
CONTINUED  

 
Installation 
instructions, 
continued  

 
Your personal certificate is protected by a password so as to ensure 
that it will not be used by any unauthorized or malicious user. Even 
though it is for test purpose, the same level of security policy is into 
force. To obtain your password, you have to send an e-mail to the 
following recipient: Yves.Hardy@cec.eu.int  
 
Once received, to continue the installation process, you just have to 
click on the “Next” button 
 

 
In this new window, you have to select “Place all certificates in the 
following store” and then click on the “Browse” button: 
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INSTRUCTIONS FOR INSTALLING YOUR PERSONAL CERTIFICATES, 
CONTINUED  

 
Installation 
instructions, 
continued 

 
 
Here, firstly, you enable “Show physical stores”. From the list, you 
click on “Personal” and then “Registry”. Once done, click, on the 
button “OK” to continue.  
 

 
This new window pops up, click “Next” 
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INSTRUCTIONS FOR INSTALLING YOUR PERSONAL CERTIFICATES, 
CONTINUED  

 
Installation 
instructions, 
continued 

 
The installation is about to be completed. Click “Finish” to import 
your personal certificate in the Windows Registry 
 
Once that package is installed, the next step is to follow the 
directions below to export your public key in your Outlook Express 
Address Book.  

1) Open your “Internet Explorer” and select the following menu: 
Tools -> Internet Options -> Content. You should get this 
window: 
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INSTRUCTIONS FOR INSTALLING YOUR PERSONAL CERTIFICATES, 
CONTINUED  

 
Installation 
instructions, 
continued 

Click on “Certificates” button, the following new window should 
appear on screen: 

 

In the Personal menu, you should see appearing the name of your 
personal certificate. In this example, I have highlighted my personal 
certificate to be used in this context. 

Then click on the “Export” button. The aim of this step aims at 
exporting and copying your personal certificate’s public key in order to 
import it afterwards in the Microsoft Outlook Express mail tool and in 
your Address book. Without this procedure, Outlook Express cannot 
be used for sending and receiving encrypted and digitally signed e-
mails to/from the other mail recipients.  
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INSTRUCTIONS FOR INSTALLING YOUR PERSONAL CERTIFICATES, 
CONTINUED  

 
Installation 
instructions, 
continued 

Click “Next” to continue 

2) Now, the wizard asks you whether you want to export your private key 
which is embedded in your personal certificate, the answer is no! 
Select “No, do not export the private key” then click on “Next” to go 
further 

3) The next step is to specify the type of data format to be used for 
exporting the personal certificate. It is important to select the 
Cryptographic Message Syntax Standard format: PKCS#7 
including all certificates in the certification path as shown 
hereunder: 
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INSTRUCTIONS FOR INSTALLING YOUR PERSONAL CERTIFICATES, 
CONTINUED  

 
Installation 
instructions, 
continued 

When done, click on “Next” to continue the process 

 

In the Personal menu, you should see appearing the name of your 
personal certificate. In this example, the personal certificate is 
highlighted to be used in this context. 

Then click on the “Export” button. The aim of this step aims at 
exporting and copying your personal certificate’s public key in order to 
import it afterwards in the Microsoft Outlook Express mail tool and in 
your Address book. Without this procedure, Outlook Express cannot 
be used for sending and receiving encrypted and digitally signed e-
mails to/from the other mail recipients.  
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INSTRUCTIONS FOR INSTALLING YOUR PERSONAL CERTIFICATES, 
CONTINUED  

 
Installation 
instructions, 
continued  

Click “Next” to continue 

4) Then, you have to specify the name of the file you want to export as 
well as its location on your local hard drive. By default, it can be stored 
in the C:\temp directory but it is not mandatory, it is up to you. In this 
example, the file is named: export_personal_certificate.p7b 

       

Click “Next” to continue and this will terminate the exportation process. 
From now on, a copy of the personal certificate is stored in the C:\temp 
directory and can be imported in the Microsoft Outlook Express tool. 
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4.4   INSTRUCTIONS FOR CONFIGURING OUTLOOK EXPRESS TOOL 
 

Procedure The last stage is to import the copied personal certificate in the 
Outlook Express mail setting and Address book which will allow you 
to sign and encrypt mail messages over the TESTA network.   
 

a. Open your Microsoft Outlook Express and click on the button called: 
“Addresses” in the main window. The following window should pop 
up 

 

 
 

b. Click on the button “New” and you select “New contact” to create 
and register your local e-mail address in Outlook Express. By this 
step, we will associate your e-mail address with your personal 
certificate 

 

     
 

Fill in the form by typing in your first name, last name, title and most 
importantly the correct syntax of your e-mail address to be used On 
TESTA: (i.e. firstname.surname@tcn.<country_code>.eu-admin.net) 
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  INSTRUCTIONS FOR CONFIGURING OUTLOOK EXPRESS TOOL, 
CONTINUED 

 
Procedure, 
continued 

When done, you just click on the “Add” button for the creation 
 

c. Still in the same window, you select the menu called: “Digital IDs” 
and the following window appears on screen: 
 

 
 

It is worth noting that your e-mail address must be displayed in the 
selection field criterion. If not, please select it before continuing the 
installation process.  

 
d. Click on the “Import” button. The objective is to import your 

exported personal certificate performed in the previous section in 
order associate this latter with your local e-mail address. Once 
imported you should get this result: 
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  INSTRUCTIONS FOR CONFIGURING OUTLOOK EXPRESS TOOL, 
CONTINUED 

 
Procedure, 
continued 

You can easily verify whether your personal certificate has been 
imported and associated correctly to your local e-mail address by 
looking at the “V” sign preceding your name as shown here above. 
If you get a “X” sign in red, then something wrong occurred in the 
importation process preventing the personal certificate to be 
deployed and used correctly. If this happens, it would be advisable 
to restart the whole installation procedure from the beginning. 
 

e. Last but not least, the final step is to install in Microsoft Outlook 
Express so that encrypted and/or signed e-mails can be sent to the 
other recipients; 

 
1. Open Microsoft Outlook Express 
2. Click on Tools -> Options from the menu 
3. Click on the “Digital IDs…” button in the middle 
4. Select your personal certificate and click “Close” 
5. Click “OK” to finish 

 
Your Outlook Express mail tool is now configured to send digitally 
signed and encrypted e-mail messages over the TESTA network 
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5.   SENDING AND RECEIVING SECURE E-MAIL THROUGH OUTLOOK 
 

Basic 
Principle 

Once your user’s personal certificate (Digital ID) is stored in your 
contacts list and associated to your e-mail address, you can send 
secure e-mail by signing and encrypting messages to other 
recipients. To enable this mode of transmission, firstly you have to 
reconfigure the Outlook Express settings as follows: 
 

1. Open Microsoft Outlook Express and in the menu Tools -> 
Options, select Security. You should get the following output: 

 

            
 

2. There, you have to click on “Encrypt contents and attachments 
for all outgoing messages” and “Digitally sign all outgoing 
messages” as shown above and then once done, you click on 
“Apply” to submit and register the changes and then “OK”. Please 
note that this change needs to be done only once. 

  
3. Now you are ready to send sign and encrypted email. In Outlook, 

open a new mail message by clicking the “New Mail” button (or 
“Create Mail”). A similar window should appear on screen: 
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SENDING AND RECEIVING SECURE E-MAIL THROUGH OUTLOOK, 
CONTINUED 

 
Basic 
Principle, 
continued 

 
On top of the window, in the toolbar, you have the liberty to 
enable/disable the “Sign” and “Encrypt” modules by simply 
clicking on the corresponding buttons. By default, both 
buttons are pressed down and the Signed and Encrypted 
icons should appear at the far right of the address fields, 
this means in other words that your message will be 
digitally signed and fully encrypted prior to be sent remotely 
 
In this context, your secure e-mail will be sent and only the 
recipient will be able to read it and will have the assurance 
that you only sent it.  

 
Note:  
 
You will not be able to encrypt the message unless the e-mail 
address you type into the “To field” has a Digital ID associated with it 
and you have stored a copy of the public key in your local mail 
Address Book  
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5.1   ESTABLISH A SECURE LINK WITH ANOTHER MAILBOX USING 
OUTLOOK EXPRESS ON TESTA NETWORK 

 
Procedure To establish a secure link with another mailbox allowing you to send 

encrypted e-mails over the network and in addition to ensure that the 
recipient will be able to decrypt the contents to read it, as explained 
in section 1 above, you have to follow the instructions hereafter.  
 
It is worth noting that this procedure is only required once, there is no 
need to repeat it whenever you intend to send an encrypted e-mail. 
 
 First, you compose a new message to send to your list of 

recipients asking them to reply to your e-mail in which they will 
sign their e-mail with their corresponding personal certificate. 
 

 Click the Digitally Sign Icon button prior to sending your 
message.  

 
 Upon receiving your e-mails, the recipients will get a copy of your 

personal public key which is attached in your message, then they 
will have to add your e-mail address in their contacts address 
book in such a way that they will be willing to send you encrypted 
messages thanks to the use of your public key  

 
 When you receive their individual response, you have to proceed 

the same way, you just have to add their e-mail address in your 
local contacts address book. By proceeding as such, you will 
store a copy of their personal public key locally allowing you to 
encrypt your upcoming messages with they keys. The secure link 
is now established end-to-end 

 
 
In Outlook Express this can be translated as follows: when receivig a 
signed message from someone for the first time, to store its Digital 
ID in your address book you: 
 

1. open the signed message from Outlook Express 
2. Select Properties from the File menu 
3. Click on Security tab 
4. Click the Display certificates  
5. Click the Add Digital ID to Address Book button 
6. Click OK  

 
Furthermore, this Security dialog also shows the ability of the 
sender’s Digital ID and the encryption, if applicable 
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5.2     MANAGING THE DIGITAL IDS IN YOUR ADDRESS BOOK  
 

Principle To view one of your contacts’ Digital IDs (personal certificates) you 
have to: 
 

a) Open the address entry for the person whose Digital ID you 
want to view 

 
b) Click the Digital IDs tab in the Properties dialog 

 
c) Select Digital ID that you want to view 

 
d) Click the Properties button 

 
To delete a Digital ID from the Address Book: 
 

a) Click the Digital IDs tab in the Properties dialog 
b) Select the Digital ID that you want to remove 
c) Click the Remove button 

 
When deleting the default Digital ID for a contact, you will no longer 
be able to send encrypted e-mail to that person 
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6.     ANNEX A  
 

List of 
country code 

The following table lists the country codes of the Member States 
involved in TACHOnet. The complete list is available at: 
 
http://www.unece.org/trans/conventn/disting-signs-5-2001.pdf . 
 

 
Country Name Country Code 

AUSTRIA A 
BELGIUM B 
DENMARK DK 
FINLAND FIN 
FRANCE F 
GERMANY (Deutschland) D 
GREECE GR 
ICELAND IS 
IRELAND IRL 
ITALY I 
LIECHTENSTEIN (Fürstentum Liechtenstein) FL 
LUXEMBOURG L 
NETHERLANDS NL 
NORWAY N 
PORTUGAL P 
SPAIN (España) E 
SWEDEN S 
UNITED KINGDOM (Great Britain) GB 
SWITZERLAND (Confederation of Helvetia) CH 
CYPRUS  CY 
CZECH REPUBLIC CZ 
ESTONIA EST 
HUNGARY H 
LATVIA LV 
LITHUANIA LT 
MALTA M 
POLAND PL 
SLOVAK REPUBLIK SK 
SLOVENIA SLO 

 
 
 
 
 
 
 


